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Conventions

PPA for DM Manual

The typographic conventions used in this manual are described below.

Convention

Bold

Menu...MenuOption

CAPS

Italics

Description

Used to denote specified elements of the user interface such as
buttons, field names, menus, and menu options.
For example, the New button.

Select the Menu from the Menu bar then select the Menu Option
from the Menu.

For example, File...Open would mean select the File Menu and
then the Open Option.

Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Used to denote emphasis, captions and the result of an action in a
procedure.
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Introduction to Peak Pairs Analysis (PPA)

PPA stands for Peak Pairs Analysis, the DigitalMicrograph plug-in for High-Resolution Peak
Measurement and Strain Mapping Analysis.

All results obtained by PPA are fully compatible with the other functions present in DM. For
example, strain maps can be analyzed and/or manipulated with functions such as histograms,
statistics (mean, standard deviation, min, max etc.), or using the corresponding buttons, such
as the Profile utility.

The main reference for the algorithm is:

The Peak Pairs algorithm for strain mapping from HRTEM images

Pedro L. Galindo, Stawomir Kret, Ana M. Sanchez, Jean-Yves Laval, Andrés Yafez,
Joaquin Pizarro, Elisa Guerrero, Teresa Ben and Sergio 1. Molina

Ultramicroscopy 107 (2007) 11861193 (doi: 10.1016/j.ultramic.2007.01.019)

This manual will help you to use of the PPA package with some worked examples. There is
also a quick reference guide at the end of this document.

Software requirements

The following is a list of the software requirements necessary to run the PPA plug-in:

- DigitalMicrograph (Gatan™ )
- USB Key Driver
-  HREM Mouse Tool Plug-in (freeware downloadable from www.hremresearch.com)

- IPU Plug-in (freeware downloadable from www.hremresearch.com)
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Software Installation

Installing USB Key Driver

The user key driver should be installed by following the instructions given by the key driver
installer. You can find the key driver installer at the plug-in page on HREM Research web
site.

Installing DigitalMicrograph Plug-ins

The DigitalMicrograph Plug-in will be provided as Gatan compiled script file(s) (.gtk) and
dynamic link library file(s) (.dll). All these files can be installed by copy-and-paste to the
folder “Pluglns.” (The Pluglns folder should exist under a normal installation of the
DigitalMicrograph).

When the DigitalMicrograph is launched after placing the plug-ins into the Pluglns folder, the
Pluglns will appear as a new menu or an addition to the standard tools.

Installing Mouse Tools i o £ R {fg )

All the files relating Mouse tool plug-in can be installed
by copy-and-paste to the folder “Pluglns.” The Mouse
tool will appear as an addition to the standard tools.

Installing IPU Plug-in

The PPA plug-in uses some functions based on the Intel’” MKL (Math Kernel Library)
provided by the IPU plug-in. All the files relating the IPU plug-in can be installed by copy-
and-paste copy. The IPU plug-in will appear as under /PU menu. Please consult the ReadMe
file that comes with the IPU plug-in.

Installing PPA CrarrTS

Fourier Space Noise Filter »
PeakPairs.gtk and PeakPairs.dll can be installed by drag- Real Space Notse Fiter ’
and-copy to the folder “Pluglns” (The Pluglns folder Set Reference Base Vectors
should exist under a normal installation of the Motif Detection N
DigitalMicrograph.) Find Peaks »

Find Peak Pairs

When the DigitalMicrograph is launched after placing the
plug-ins into the Pluglns folder, PeakPairs menu
commands will appear.

Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project »
Image Group »

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide »
Add Color Marker

Create Vector Map...

Distortion Correction >

Help »
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Getting Started

Image pre-processing and Basis Vector Selection
(Bragg Filter)

-

i F: QuantumWire

PPA for DM Manual

Open the file QuantumWire.dm3 using the DM command File...Open:

This image represents a
capped InAs quantum
wire on GaAs.
Composition was consi-
dered to be uniform
inside the quantum wire
and across the wetting
layer.

All the commands related to PPA are located in the menu Peak Pairs. The first command to
be applied to a new image is the Power Spectrum command to calculate the power
spectrum of the image:

= D: Power Spectrum of QuantumWire

Help

i

m Help -
= Fourier Space Moise Filter 4 Power Spectrum ]
i| Real Space Moise Filter 4 Bragg Filter...

Set Reference Base Vectors

Motif Detection .3

Find Peaks .3

Find Peak Pairs

Displacement Maps

Define Peferanra

strain | Hint: if the Power Spectrum

Repeat| 2PPEATS completely blacl.<, you
will probably need to adjust

Project|  the histogram

Image

fnalyzd Histogram - X

Analyzg

Histogn PI'CSS

Show/H here

Create

Distorti

(o]l o s
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Now, select the HREM mouse tool, and
click on desired spots to apply Bragg filter.
The usual choice is to select the brightest
spots in the spectrum, but those
corresponding to higher harmonics can also
be selected:

The user doesn’t need to hit the spot exactly,
because PPA looks for the local maxima near
the selected point.

Anyway, you can zoom in the spectrum
before hitting peaks using the DM zoom
tool:

= D: Power Spectrum of QuantumWire

PPA for DM Manual

i & L R} @ T

Y o9 W

Hint: if you wish to delete any spot,
just click on the mouse mark again
with the SHIFT key down.

Hint: Symmetry in the selection for
each spot is assumed.

IMPORTANT: First and second chosen spots (numbered as 1 and 2) will define the lattice
basis vectors. These spots should be apart from the vertical or horizontal of the central spot, in

order to obtain maximum resolution.

Don’t be surprised if the central spot is not present in the power spectrum. It just indicates that

the mean intensity of the image is zero.
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We are now ready to apply Bragg Filter. This process creates an image where the contrast
resulting from the ordered regions is clearly distinguishable from the background intensity.

PeakPairs | Healp

4 Fourier Space Moise Filter

-

Power Spectrum i

Real Space Moise Filter ! Bragg Filter...

Set Reference Base Vectors
Motif Detection 3
Find Peaks 3

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...

-

Project

Image Group 3

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide 3
Create Vector Map...

Distortion Correction 3

Help »

iz D: Power Spectrum of QuantumWire

= Bragg Filter

(S

Project Name: |[Project!

Size:
[sma -] [pos

Smoothing Width: |50
[~ OwalRstio: [05
Direction: [450 degres

w2 )

0K Cancel

e

iz Bragg Filter

Project Name: | Project 1]

Size:

305 pocls
Smoothing Width: T
["|ovalRatio: [0.5
Direction: W degree

[ OK ] [ Cancel

The shape and size of the Bragg filter must be
adjusted such that no loss of information
occurs. In this dialog box we can determine the
size (in pixels), smoothing width(in pixels),
oval ratio(height/width) and direction(in
degrees) of mask spots.

By pressing the Apply button, the mask
described by the chosen parameters will be

redrawn, as it is shown in the example on the
left.

Let us select the first option (small
window, oval ratio=1) and press the OK
button, and the Bragg filtered image will
appear immediately.

If Bragg filter parameters are properly
chosen (big masks and a sufficient
number of peaks), the resulting filtered
image will preserve the location of
maxima. The great advantage in using
the filtered image is the reduction of
noise.

= L: Project1 Bragg Filtered QuantumWire
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Peak Detection (simple images)

PPA for DM Manual

IMPORTANT: Peak Detection uses two base vectors information (unit cell) to find a set of
good intensity peaks. The Bragg filter defines the two base vectors automatically. However,
in the case of the Real Space Noise Filter, the two base vectors should be defined
manually using the Set Reference Base vectors command.

Once we have a Bragg filtered image, the next step is to locate peaks of intensity in the image

by using the Find Peaks menu commands.

The approach to peak detection is based on peak
identification based on their intensities.

The Peak Histogram command detects all
intensity maxima in the image, and calculates the
histogram of peak intensities.

The histogram allows the user locating different sets
of peaks, based on their intensities, for determining
strain. This discrimination is obtained by defining a
lower threshold using the histogram. All peaks of
intensity lower than this threshold are discarded.

Here, we use Test image.dm3 as a sample data. First, we
apply the Bragg filter using all the spots in the Power
Spectrum. When the command Peak Histogram is issued,
the following dialog box allows the user to specify if the user [
is interested in white (unchecked) or black spots (checked)

using the Invert Peaks checkbox option

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project

Image Group

Analyze Lattice Points
Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide

Add Color Marker

Create Vector Map...

Distortion Correction

Help

PeakPairs

4
»

Peak Histogram...
Find Peak Positions...
Remove Peaks

Add Peaks

iz Peak Histogram | 25 |

(| Invert Peaks

OK

][ Cancel ]

Once the histogram is shown, the user should select the intensity threshold for identifying
which peaks will be used in further analysis. To do so, just click the mouse on the histogram,
and select the desired range of peaks. The left side of the selection made in the histogram will
be used in the following Find Peak Positions command.

# _)L"; | 1 / Fan N | v F: Peak Histogram of Project?2 Bragg Filtered Test image
C 7 :

k select 200

Select and move objects 180

160

140

120

100

80

60-

40

20

2.705 He—————0.442 ——— e

26 2.8 3.0

10
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ti- H: Projectl Bragg Filtered Test image  [= || & |[x23)

The discovered peaks will be classified to red or blue depending on the peak values: red
indicate the peak that is higher value than the selected threshold, while blue indicate the peak
equal to or lower than the threshold. The peak colour will be dynamically revised by changing

the threshold.

Once the range of peaks is selected, the Find Peak Positions should be issued.

PeakPairs
Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project

Image Group

Analyze Lattice Points
Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide

Add Color Marker

Create Vector Map...

Distortion Correction

Help

»
»

4
»

C

Find Peak Positions...

Add Peaks

D

—

The following dialog box appears:

23|
[ Invert Peaks

Peak Threshold: | 0.825
Minimum Peak Distance: | 3.0

Show Local Maxima

iz Find Peaks

[ OK ][ Cancel ]

Peak Threshold indicates the minimum intensity
of a point to be considered as a valid peak. Peaks
having intensities below this threshold will be
discarded. Peak threshold value is automatically
read from the left side of the selection made in the
histogram. However, the user can manually
modify this value, if necessary.

You may want to use Minimum Peak Distance
(in pixel) to restrict a minimum distance between
nearby peaks.

By pressing OK, we get a first set of peaks shown as coloured spots over the filtered image.
Blue dots represent local maxima (8-neighbourhood) on a pixel basis. Red dots represent
refined maxima at sub-pixel resolution. Sub-pixel resolution is achieved by fitting a 2D
quadratic function and calculating analytically the maxima, as described in the reference for
the algorithm in the Introduction section.

11
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¢ H: Project1 Bragg Filtered Test image o5

Sometimes, extra peaks are obtained in this automatic Peak Finding process, especially at the
borders of the image. Repeating the Find Peaks command with a new Peak Threshold, all
peaks in the border of the image will be discarded and won’t be considered in any further

calculations.

12
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Motif Detection (complex images)

In cases where the repeating unit in the image is more complex than a single dot, such as a
dumbbell, an alternative, more complex way to determine the lattice may be useful. Thus, the
Motif Detection has been implemented. Here, we explain the Motif detection using the
image QuantumWire.dm3.

First, a rectangle should be defined using the Rectangle ROI tool. The rectangle defines the
basic pattern that will be searched across the whole image using normalized cross-correlation.
For example, in this image, a cation location (an upper part of a dumbbell) may be a good
choice. Rectangle size and location is a critical decision in the accuracy of strain results. Let
us zoom in the substrate, and select a rectangle area around a cation.

(o /-5

= L: Project1 Bragg Filtered QuantumWire

ix l

"1 Rectangle
Add a rectangle ROIL

Once the rectangle has been defined, select the x-Corr Histogram in the Motif Detection
submenu. A dialog shown below will open:

PeakPairs | Custom Help

Fourier Space Noise Filter

Real Space Noise Filter
Set Reference Base Vectors

Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project
Image Group

Analyze Lattice Points

Add Color Marker
Create Vector Map...

Distortion Correction

Help

>

5

x-Corr Histogram...
T —

Find Motif Centers...

—)

iz x-Corr Histogram

25

Project Name: | Project1|
Approximate Column Size (diameter):

Minimum Motif Distance:

| 10.0

20.0

| o

J

Cancel ]

After clicking OK, a new window will appear showing the histogram of all maxima in the
normalized cross-correlation between the selected pattern (Motif) and the whole image.

iz P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire

[E=8 HoR =3

13




HREM Research Inc. PPA for DM Manual

In this case, we may observe two peaks in the histogram, corresponding to Ga and In cations
across the image.

Once the histogram is shown, you should select the intensity threshold for identifying which
peaks will be used in further analysis. To do so, just click the mouse on the histogram, and
select the desired range of peaks.

i *_ Q | A / }/ . . iz L: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire (=2 i=R =
g -

Select i o

Select and move objects

0.96 ++0.04 |

050 055 0.60 0.65 0.70 0.75 0.80 0.85 0.90 0.95 1.00

The discovered motifs will be classified to red or blue depending on their cross-correlation
values: red indicate the motif, whose cross-correlation value is higher than the selected
threshold, while blue indicate the motif equal to or lower than the threshold. The peak color
will be dynamically revised by changing the threshold.

iz H: Project1 Bragg Filtered QuantumWire

Given that we are interested in the detection of both cations, we will select a threshold lower
than 0.9 to take all peaks into consideration. To do that, the Select tool should be used by
dragging the mouse on the histogram directly. The left edge will be used as a lower threshold.

*_ _‘ Q | A / )/ . . ¥z P: Peak Histogram_X-corr of Motif With Project1 Bragg Filtered QuantumWire [folf® ==
300
C - :

k Select P
Select and move objects

14
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Next, the x-Corr with Refined Motif command will show the refined Motif, which is
calculated as an average only from the areas that will give cross-correlation values higher than
the specified threshold.

PeakPairs | Help

Fourier Space Noise Filter b

Real Space Noise Filter »

-

(E=8 EoR =)

P
Set Reference Base Vectors -
e oo | o)

Motif Detection >

Find Peaks x-Corr with Refined Motif

Find Peak Pairs
Displacement Maps 1
Define Reference i

Strain Map...
Repeat Project...
Project 4 i
Image Group » i

Analyze Lattice Points

Analyze Column Positions...

Histogram from Spreadsheet i

Show/Hide » bso 0.95 1.00
Add Color Marker

Create Vector Map...

Distortion Correction »

Help »

Then, this command will show the cross-correlation between the refined Motif and the whole
image. This is especially useful in the presence of noise.

= T: Peak Histogram_X-corr of Refined Motif with QuantumWire o 5=
450

400

350-

300-

Once the refined histogram is shown, the user should select the intensity threshold on the
refined histogram as before

&= T: Peak Histogram_X-corr of Refined Motif with QuantumWire &=
,&._Q'A/}/.. =3 istogram ) with Q i =
400 H =
k Select :
I Select and move objects 0 '
300
250-
200-
150
100
0
05 o055 os0  oes o7 o7 os o8 0% 03 100

The discovered motifs will be classified to red or blue as before. The peak colour will be
dynamically revised by changing the threshold.

15
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= H: Project1 Bragg Filtered QuantumWire [ [®@]=]

And then select the Find Motif Centers in the Motif Detection submenu.
PeakPairs | Custom Help

Fourier Space Noise Filter »
Real Space Noise Filter » . | E ;
Set Reference Base Vectors t“;“: Flnd MOtIf cen S
Motif Detection » x-Corr Histogram...
Find Peaks S Peak Threshold: | .69

. - Find Motif Centers...
Find Peak Pairs
Displacement Maps ShOW a" pOlntS
Define Reference -
|:> Show stacked motif
Repeat Project...
. Lok J[ concel |
Image Group »

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide »
Add Color Marker

Create Vector Map...

Distortion Correction »

Help »

The Find Motif Centers command finds the motif positions by taking into account the
minimum motif distance, and places the red small boxes on the motif centers (the center of
the motif box).

= B: Project1 Bragg Filtered QuantumWire

IMPORTANT: In the case of Motif Detection, the reference base vectors should be selected
using the Set Reference Base vectors before applying the Find Peak Pairs command.

16
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Peak Pairs Determination

IMPORTANT: Peak Pairs are calculated using two basis vectors. The Bragg filter defines
the two base vectors automatically. However, in the case of the Real Space Noise Filter or
Motif Detection, the two base vectors should be defined manually using the Set
Reference Base Vectors command.

Once all peaks or motif centers have been selected, Peak Pairs should be calculated using the
Find Peak Pairs command. This process will find all pairs of peaks along the predefined
two basis vectors.

SRR Help ' H: Bragg Filtered Test image
F Fourier Space Noise Filter 3 r = P
| Real Space Moise Filter » n n .
Set Reference Base Vectors
4 Motif Detection 3
s Find Peaks 3
c Find Peak Pairs
S
Define Reference
Strain Map...
Repeat Project...
Project »
Image Group »
Analyze Lattice Points
Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide 3
Create Vector Map...
Distortion Correction 3
Help »

Motif Detection

17
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Displacement and Strain Maps calculation

Once all Peak Pairs have been determined, we can proceed to the calculation of displacement
maps using the command Displacement Maps. This generates horizontal and vertical
displacements (D1h, D1v, D2h and D2v).

PeakPairs | Help vz Q: Project1 D1h [ -Er]ms] | - T: Project: D1v [el=]x]

Fourier Space Noise Filter »

Real Space Moise Filter 3

Set Reference Base Vectors
Motif Detection 3
Find Peaks 3

K | ———
D

Displacement Maps
Gl

Strain Map...

Repeat Project...
Project 3

Image Group 3

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide 3
Create Vector Map...

Distortion Correction >

Help 3

Technical note:
PPA uses an automatic selection of contrast and the temperature color scale for
displaying image values. Default color range is +5%.

If you prefer a grey scale or a different contrast limit, press the right button on the
image, and modify ImageDisplay options properly.

Changing this option will not change the actual values, only its appearance.

A very important step is to define the reference area, that is to say, the area that is considered
to correspond to the reference lattice.

All displacements and strain values will be referred to this area. Use the Rectangle ROI tool
(region of interest tool) to select an area on any one of the Displacement images (D1h, D1v,
D2h or D2v):

TRl NN SRRy e Pt oo el

iL.J Rectangle
Add a rectangle ROI

18
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Once the reference area has been chosen, the user should select the Define Reference
command. This will change the displacement values, so as to obtain a uniform displacement

in the chosen reference area.

PeakPairs | Help

Fourier Space Moise Filter 3

Real Space Moise Filter 3

Set Reference Base Vectors
Motif Detection 3
Find Peaks 3

Find Peak Pairs

= Q: Project1 D1h

[e=l-EJ@sa] | - T Projects D1v =]

< Define Reference >
Strain Map...
Repeat Project...

Project
Image Group 3

Analyze Lattice Points
Analyze Column Positions...

Histogram from Spreadsheet

Show/Hide 3
Create Vector Map...

Distortion Correction 3
Help 3

e St Project1 D2h

[ (@ ][] | ¥ u: Project1 D2v [e@][=]

The final step is the determination of strain maps (exx.€yy.€xy and eyx) at the desired angle.
When the Strain Map command is selected, the Strain Map dialog appears. Here, you can
specify the coordinate axes to display the strain maps using Angle of x-axis to horizontal. If
the angle is set equal to 0, horizontal and vertical directions are assumed to be x and y

coordinate axis respectively.

PeakPairs | Help

Fourier Space Moise Filter ]

Real Space Moise Filter ]

Set Reference Base Vectors
Matif Detection 3
Find Peaks 3

Find Peak Pairs

Displacement Maps

M
C Strain Map... >
Project ]
Image Group 3

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide 3
Create Vector Map...

Distortion Correction L3

Help 3

= Strain Map [

Option

Angle of x-axis to horizontal: | 7.5 ‘

Show the following images
Strain Matrix
() Independent

@ Symmetric
[~]Mean Dilatation
[~] Rotation Angle

‘EE I Pl‘ﬂ k

,.' Line

The angle of x-axis to horizontal may be determined
graphically. To do so, just add a Line ROI on the
original image, along the desired direction of x-axis,
before issuing the Strain Map command.

g F: QuantumWire =5 g )
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Once the OK button is chosen, a set of 4 images corresponding to (exx,eyy,exy and eyx) are
obtained. The mean dilatation and Rotation angle are additional images available.

There is an option for strain representation (Overlay):

DESCRIPTION Full image Detail

No overlay:
Continuous strain
maps are shown.

! | Gk proecti e [o [ & )

Hint: If you prefer a grey scale or a
different contrast limit, press the right
button on the image, and modify
ImageDisplay options properly.

T

Overlay:

Strain maps at
each atomic
column are
shown with
colour dots over
the original
images.

Technical Note:
The results of the PPA package is the complete strain tensor defined as follows:

Strain values

du du, ou ou,
exx = o D eyy = P D) ew = P ’ eyx =
)y )y ox
Strain tensor:
_1(ou + BL : ou au, 1(0u, Odu,
i 1.C. .= X,gyy: ,gxy=— —x 4V
2{dx, ox; ox ay 2( ay  ax

Mean dilatation :

1(ou, Ou;) .
b 5(3_3_] Lo A, =3{en+ey)

J
Rotation (in radians and anti-clockwise positive):

20
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Setting the Reference Base Vectors

It is possible to manually set the reference base vectors.
To manually define the Reference Base vectors, use the HREM Mouse Tool to select 3
points in the order (origin of both vectors, terminal point of vector 1, terminal point of vector

2), so that the directions of the desired reference base vectors are described by the directions
of vectors 1->2and 1->3.

(0sidE)

Approximate directions
as described by the user

When applying the Set Reference Base Vectors command, the precise magnitude and
direction of both reference base vectors are calculated using a least-squares fitting to all the
peaks within the parallelogram defined by two vectors 1->2and 1->3.

PeakPairs | Help ti= C: Projectl LPF of PPA Test 1
= Fourier Space Moise Filter 4 z- . - - i [.- '
Real Space Moise Filter 3 i § i . L 3 £l
, L L L
( Set Reference Base Vectors -' .‘ . .
) 3 W L] !

Find Peaks » . .

Find Peak Fairs

Displacement Maps

Define Reference
Strain Map...
Repeat Project...

Project 3

Image Group 3

Analyze Lattice Points

Analyze Column Positions...

Histogram from Spreadsheet

Show/Hide 3
Create Vector Map... Reference Base Vectors
Distortion Correction »
Help 3

21
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Real Space Noise Filters

While Bragg filtering is very useful to reduce noise, some researchers may prefer other
alternative noise filtering techniques in real space. There are two alternative noise filtering
commands: Adaptive Wiener Filter and Low Pass Filter. The techniques have no way to
determine automatically the basis vectors, and they should be determined manually by using
the Set Reference Base Vectors command

Adaptive Wiener Filter

The Wiener filter is widely used for image restoration and calculates the optimal filter for the
removal of noise from a signal which is corrupted by the measuring process itself. It assumes
that if noise is present in the system, then it is considered to be additive white Gaussian noise.

In a typical Peak Pairs session, if Wiener filtering is desired, it is usually the first operation to
be applied to the original image. When applying the Adaptive Wiener Filter on the front
image, the user should decide the size of the windows used for calculating the Adaptive
Average and the Noise Estimation, as follows:

PeakPairs | Help

Fourier Space Noise Filter »

Real Space Noise Filter Adaptive )

Set Reference Base Vectors

iz Wiener Filter [
Motif Detection 3

v Rete ' New Project: | Project1

Find Peak Pairs

Displacement Maps Adaptive Average: | 1 x2+1pixels
Define Reference

STk Noise Estimation: |1_ x2+1 pixels

Repeat Project...

g ' OK Cancel

Image Group » [ ] [ ]

Analyze Lattice Points

e If the standard deviation of the local area is small, then the
=D ' pixel value will be replaced by a local average. On the other
Create Vector Map.. . . . .

Ditotion Comection » hand, if the standard deviation of the local area is large, then
Hep » the pixel value will not be modified. Thus, the new pixel value

will be between the old value and the local average according
to the local standard deviation.

The result of the Wiener filtering operation on 7est image.dm3 (Adaptive Average =3, Noise
Estimation=3) is depicted below.

= B: PPA Test 1 = |- = 5] | v I: Projects AWF of PPA Test 1 o | & ==
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Low Pass Filter

In order to generate a Low-Pass filtered image, use the Low Pass Filter command on the
front image. The strength of the filter is defined by the Radius of the mask in pixels (the
larger the radius, the stronger the filter):

(PeakPais |
Fourier 5pace Noise Filter D—
Real Space MNoise Filter 3 ’A%
Set Reference Base Vectors e
Motif Detection v l:'"" Low Pass Filter l&J
Find Peaks v -
Find Peak Pairs I::> New Project: |Project3
Displacement Maps
Define Reference Radius(pixel): 2.0
Strain Map...
[ OK ] [ Cancel ]
Repeat Project...
Project 3
Image Group 3 . . .
- The new pixel value will be a local average with a
Analyze Lattice Points . . .
P e Gaussian weight (mask) of the defined radius. You
Histogram from Spresdsheet can specify a radius of les than one pixel.
Show/Hide 3
Create Vector Map...
Distortion Correction 3
Help 3

In the following figure, the resulting images after the application of a Low-Pass filter to the
lower left part of Test image.dm3 with different radius are shown:

”

i B: PPA Test 1 o |[@][ =]

Original image Low Pass Filtered Low Pass Filtered
(right-lower corner only) (radius=0.8 pixels) (radius=1.6 pixels)
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Geometric distortion correction

All optical systems distort the images they form. CCD cameras and scanners (for digitising
negatives for example) introduce additional distortions. If these geometric distortions are
fixed (what is usual for a given system), it is possible to eliminate them. This is valid not only
for projector lens distortions but also for any other systematic distortions present in the image.

In order to correct the distortions, an image of a perfect crystal is needed. We explain here
distortion correction using a pair of images with the same distortion, 7est image.dm3 and
Substrate.dm3, the latter of which corresponds to an image of a perfect crystal.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

téz A: Power Spectrum of Substrate [e)[®@] =

¢iz B: Substrate [olre ==

- Bragg Fiter
Project Name: [ Project1

Size:
Smoothing Width: [5.0
[VlovalRatio: [1.0
Direction: [0.0  degree

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

ez N: 5 Q:
Filtered Substrate &= N: Project1 D1h = [@ =] | & Q: Project1 Div ol[@][=

= P: Project1 D2h = |[@ ][] | & R: Project1 D2v o @)=
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The distortion information obtained for the perfect crystal image can be used to correct
distortions in any other image with the same distortion. In order to obtain the distortion
information, select the image with Peak Pairs information, and apply the command Obtain

Distortion Info.

PeakPairs | Help

Fourier Space Moise Filter

Real Space Moise Filter

Set Reference Base Vectors
Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project

Image Group

Analyze Lattice Points
Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide

Create Vector Map..,

Distortion Correction

Help

s

s

»

(€

Obtain Distortion Info ,

Distortion Info of Substrate [fole ==

The new image with distortion information will be created. This Distortion Info image can be
saved to disk (e.g., Distortion Info of Substrate using Save As command) and used in further
analysis of the image having the same distortion.

In order to rectify the original image using the distortion information obtained from the
perfect crystal image, just apply the Correct Distortion on the Target Image as follows:

PeakPairs | Help

Fourier Space Noise Filter

Real Space Noise Filter

Set Reference Base Vectors
Motif Detection
Find Peaks

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project

Image Group

Analyze Lattice Points
Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide

Create Vector Map...

»

»

3

Distortion Correction ‘ b

Help

»

e
Correct Distortion... >
aln Ulstortion [nfo

Rectify Image...

g Correct Distortion @_J
Target Image: [D: Testimage 918k v]
Distortion Info: [S: Distortion Info of Substrate 2758k v]

[ OK ] [ Cancel ]

Select the Target Image (the image to be
corrected), and the Distortion Info (the image
created by the Obtain Distortion Info command).

Here, we use the Test image.dm3 and the Distortion
Info obtained from Substrate.dm3.
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This will produce a corrected image, where all the est image oo e
distortions estimated from the perfect crystal image |#&
have been eliminated.

We can now proceed to analyze this image in the
usual way to get the final results:

Define reference
Strain maps

1. Power Spectrum

2. Bragg Filtering

3. Find Peaks

4. Find Peak Pairs

5. Displacement Maps
6.

7.

The strain maps before and after distortion correction:

~y ~y

iz J: Project2 exx [o][@ ][ =] | g L: Project2 eyy [a[@] =] o W:Projectdexx [ o | @ |[ 88 ] | ¥ Y: Project eyy [e[@]=]

g M:Project2exy  [o | @ |[ 8| | gz O: Projec2eyx [o |[@ [ 5= ]

- Z: Project4 exy t= AB: Projectd eyx [ o || @ [ 52|

before correction after correction

If we plot a horizontal profile across exx and a vertical one across eyy, we get the expected
results (exx=0.1 and eyy=0.05) after distortion correction.

= D: Profile Of Projectd exx [E=R[E=R~= = G: Profile OF Project4 eyy o [@]=]

o.

on
010
008
0.08
007
0.06
0.05
0.04
003
002

001

0.004
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Lattice Analysis (Analyze Lattice Points)
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The Analyze Lattice Points command applied on the project image, such as Bragg filtered
image, will generate an output in spreadsheet including the following information (one row

for each lattice peak):

- Peak position at sub-pixel resolution (x,y coordinates)

- Peak intensity

- Strain tensor at each lattice peak (exx,eyy,exy and eyx): only after Strain Analysis.

PeakPairs | Help

%= D: Lattice Points of Project3 Bragg Filtered PPA Test 1

[E=8|ECE

=)

4 Fourier Space Moise Filter 3 X I3 Height axx ayy axy awx -
Real Space Noise Filter » mean |237.574 238.692 2.82694 0.0279326 0.0146443 -0.00534172|-0. 00987758 ‘:|
I std | 137.592 136.723 0.119333 0.0480278 0.0317812 0.0146783 0.0149231
1 Set Reference Base Vedtors P1__ |e.72518 11.8867 2.68881 -0.066703 | -0.0428194 |0.0263026 |0.0260612
£z |7.13692 241.753 2.852 -0.0333832 |0.0203174 [-0.01035 | -0.00651274]
Motif Detection » 23 |7. 12398 229.672 2.81862 -0.0407684 |-0.00025243[0. 00138291 |-0.00871415
Find Peaks v P4 |7.20826 205.776 2.7538 -0.030673 | -0.0076317 [-0.00267347-0.0151094
Py |7.2091 217.682 2.79 -0.0375265 |-0.00326502| -0. 00502334 -0. 0186023
- : P5_|7.22218 279178 2.84895 -0.0368814 |0.0397605 | -0.0101031 | -0.0231907
ind Peak Pairs
P7 7.22584 254. 169 2.77886 -0.0361018 | 0.047856 -0.0138327 |-0.0149577
Displacement Maps P8 7.24878 266.711 2.63983 -0.0338632 | 0.042157 -0.0012523 |-0.0256778
D P9 |7.30935 193,864 2.91845 -0.033584 | -0.00427666( 0. 00582282 | -0.00279915
efine Reference
P19 _|7.33796 291.671 2.79103 -0.0388477 |0.0460278 |-0.0152384 |-0.0136449
Strain Map... Pi1_|7.a1728 304.227 2.75082 -0.039785 |0.0461599 [-0.0137371 |-0.0260204
P12 |7. 22204 181.897 2.89344 -0.039371 |0.0038951 [0.00115376 |-0.00858061
Repeat Project... P13_|7.54168 169871 2.66301 -0.0433459 | -0.00104136| 0. 00535647 | -0.0108181
Project » P14 |7.58362 316.693 2.73329 -0.0418819 | 0.0348251 -0.0202437 |-0.026883
P15 |7.7027 157. 965 2.6661 -0.0400217 | -0.00907148 0.00656087 |-0.00788249
)uﬂﬁiﬁl——— * P16 |7.73623 329.073 2.66285 -0.042683 [0.0332012 |-0.0172725 |-0.0306297
P17 _|7.87523 146,064 2.76209 -0.0403106 |-0.00709395(0. 0125334 | -0.00436709
( Analyze Lattice Paints P18 _|7.91922 341.448 2.85664 -0.0358251 |0.0306097 [ -0.0253737 |-0.0389183
P19 |8.07366 353.783 2.82647 -0.0327167 |0.0273665 | -0.0159979 |-0.0378463
P20 |8.11374 134.204 2.693 -0.0481512 |-0.0159224 |0.0173555 | -0.00192633
Histogram from Spreadsheet £21 8.2421 366.123 2.79355 -0.0347414 | 0.0316551 -0.0269653 |-0.0378734
show/Hide » P22 |8.40503 122. 458 2.68165 -0.0506372 | -0.0154679 |0.0149579 -0.003593878
£23_|8.50759 378.452 292367 -0.0389204 |0.0225894 | -0.0252833 |-0.0330471
Create Vector Map... P24 |s.6783 110.53 2.73576 -0.0523373 [-0.00043692[0.0197727 [-0.00410333
Distortion Correction b P25 _|8.72908 390,634 2.8968 -0.0420334 [0.0165246 |-0.0227335 |-0.0380875 | _
: |
Help 3

It is also possible to get a histogram from the Spreadsheet by using the Histogram from
Spreadsheet command, thus obtaining a different histogram for each column in the

spreadsheet.
PeakPairs | Help
Fourier Space Moise Filter »
Real Space Noise Filter »

Set Reference Base Vectors
Motif Detection »
Find Peaks 3

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project 3

Image Group »

Analyze Lattice Points

alumn

Histogram from Spreadsheet

Create Vector Map...

Distortion Carrection 4

Help 3

e |

e

=il

il

e

Sl

[=I=]rE=]

80

70-

60
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Atomic Column Analysis (Analyze Column Positions)

Once Peak Pairs have been located, it is possible to analyze atomic column positions. This is
very useful when there are more than one atomic column within a unit cell. For example, in
the case of [110] projection of InP (the zincblende type materials), we can evaluate cation
and/or anion atomic columns. In order to do so, go through the following steps (on the

zincblende.dm3):
- Calculate Peak Pairs in the usual way

- Bring the original raw image to
frontmost.

- Choose the area of interest on the
original image using the Rectangle ROI
tool.

- Select atomic column(s) to be analysed
using the HREM mouse. (Here, we
select a set of cation and anion columns)

- Bring the project image with Peak Pairs
information to frontmost.

- Apply the Analyze Column
Positions command

ti= N: Project4 AWF of zi

ncblende_110

o= |==]

.___‘__

.___‘__

TPeakpairs | Hew All the columns in the selected area will be shown in the
Fourier 5 Maoise Filts 4 . . . . .
e image, and the intensity of each column will be stored in a
eal Space Noise Filter 13
Set Reference Base Vectors SpreadSheet
Motif Detection 3
Find Peaks v g D: zincblende_110
Find Peak Pairs
Displacement Maps
Define Reference ' -

Strain Map... :9 :
Repeat Project... _‘: :
Project 4 : E
Image Group 3 i ;,
( Analyze Column Pasitions... > E 9:

- o o |
Show/Hide v i |-
Create Vector Map... E ™ :
Distortion Correction 4 : ] 1'
Help 3 :.m Qi

‘ o
|-
»
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- U: Distance_zin...

-2 'S c 5
mezn | 6. 36442 iz AD: Peak_zincblende_110 o || =]
st oo | e

6.36616 mean |101.92 106. 428 0.308528 104. 098 112,408 0.0830263 |J
i S. 37164 stgd |44.1637 44,1373 0.00148186 | 441625 44. 14186 0.000641297
zg:i 8: 203395 Pasl |35.7585 43,3015 0.310308 37.9353 43,8847 0.0832183
Poss | 6. 38842 Pos2 |31.5959 58.2847 0.3035591 33.7363 64.273 0.0818131
Post | 6. 34961 Posd |27. 4461 72.703986 0.30373 29.6053 78.7041 0.08291392
Pos7 | 6. 37638 Pos4 |35.6929 95. 4385 0.304943 37.9096 101.507 0.0836382
Posd | 6. 40828 Poss [31.543 109. 836 0.307186 33.7247 115.84 0.0841873
Posd |6.374 Posd |39.8894 81.0487 0.30447 42. 0678 87.011 0.0830656
PosiG| 6. 37056 Pos7 |27.346 124.283 0.30509 29.5528 130.245 0.0826102
- Posd |44.0382 66.6424 0.303348 46.2168 72.669 0.0830897

Posg |52.4104 37.8387 0.306119 54.5977 43,8237 0.0837043
Posig| 48. 2239 52.25339 0.3035862 50.3818 58.2473 0.0817484 i
T T TR BT T
y b
If there is more than one column, the user will % Analyze Column Positions (o]

have the option to evaluate the distances between

the columns. Distance |Angle| Option |
1 @2 [E13
Distances from the checked point(s) to
other points will be evaluated.
Lok [ concel |
If there are more than two columns, the user will i Analyze Column Positions [ S

have the option to evaluate the angles subtended

by two neighbour columns.

Distance Angle |Opﬁon|

M1 @2 O3

Checked point(s) will be a vertex of angle(s)
subtended by two other points.

ook J[ cancel

)

You can see visually the distribution of distances using the Histogram from Spreadsheet

command:

i H: 12

6.

5=

5.5

5.0

45

4.0

3.5

3.0

2.5

2.0

15

1.0
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Create Vector maps

It is possible to a create vector map from two vector components, such as D1h and D1v. To
do so, launch the Create Vector Maps command, and select two vector component images
of the associated vector map.

We explain here this function using the displacement maps, D1h and D1v, calculated from
Substrate.dm3. After launching the Create Vector Map command, select these two images,
D1h and D1v, and press OK.

PeakPairs | Help

M=

= Create Vector Ma @
Fourier Space Moise Filter 3 o= P
Real Space Moise Filter » Select two components

Horizontal: [O: Project3D1h V]
Set Reference Base Vectors
Motif Detection » Vertical: [R: Project3 D1v V]
Find Peaks 3 Arrow

Interval: | 16 pixels
Find Peak Pairs
Length Scale: Im—
Displacement Maps
(Length = Scale * Interval)
Define Ref
efine Reference Color: R 100 % G [o— % B |0 %
Strain Map...
Repeat Project. [ cancel ]
|
Project ]
" g ~\

I G 3 R = ) [
e t- Z: Project3D1h [ |[(E-|[5] || - AC: ProjectaDv [o |[@ [ |

Analyze Lattice Points
Analyze Column Positions...

Histogram from Spreadsheet

Create Vector Map...

1510 on 3

Help 3

Then, you will get a colour map corresponding to the vector magnitude, with arrows showing
the directions and magnitudes of the vectors as shown below:

& K: Vector Map =3 )

The vector map here is a complex DM image, whose real and imaginary parts correspond
respectively to the Horizontal and Vertical images selected in the dialog.
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Image rectification

This command allows the user to correct any distortion from an image of a perfect crystal,
using Peak Pairs information. We explain here distortion correction using an image
corresponding to a perfect crystal, Substrate.dm3.

Open the image Substrate.dm3, execute the Power Spectrum, and then Bragg Filter in
the usual way by selecting relevant spots in the Power Spectrum.

A: Power Spectrum of Substrate o |[®@][=]

: Substrate

Smoothing Width: | 5.0
[VlovalRatio: [10
Direction: [0.0  degree

Then calculate the Peak Pairs using the usual commands (Find Peaks followed by Find
Peak Pairs). If we analyse the displacements with the Displacement Maps command, we
can observe that the image of a perfect crystal is distorted as shown below.

= % V: Project4 D1h '@ ][] | g Y: Project4 D1v
- H: Project4 Bragg Filtered Substrate [foa == = L - ) L =0

= X: Project4 D2h o |[@][ =] | g Z: Project4 D2v o [@] =
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Given that the image corresponds to a perfect crystal, we can get a rectified image. In order to
do that, select the project image with Peak Pairs information, and then apply the Rectify

image command.

PeakPairs | Help
Fourier Space Moise Filter 3
Real Space Noise Filter 3
Set Reference Base Vectors
Motif Detection 3
Find Peaks 3

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project 3

Image Group 3

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide 3
Create Vector Map...

Distortion Correction L4 Correct Distortion... *
Help 3 % .
Rectify Image... .

28

Base Vector 1

Length: | 8.6

Base Vector 2

Angle: |-135.2 (-135.2086)

Length: | 8.59 (8.58744)
Angle: | 134.8 (134.792)

(8.6019)

| o

][ Cancel ]

The lengths and angles of current reference base vectors will be shown in the dialog. If the
values in the parentheses differ from the values expected from an ideal unit cell, you can

change the values accordingly.

By pressing OK, the distorted image is rectified using the local distortions at each point of the
image. To verify this, calculate the displacement maps from the rectified image. Then, we
observe that distortions have been corrected as shown below:

= V: Project4 D1h

[=][@ =] | g Y: Project4 D1v

[E=8 EoR =)

= X: Project4 D2h = Z: Projectd D2v

(=@ =]

before correction
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Bz AC: Project5D1h [ o |[@ |[ = | | gz AF: ProjectsDIv [o |[@ |[ =]

e AE: ProjectsD2h [ |[ @ |2 ] || = AG: Project5D2v  [ro- |- (3w

after correction
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Appendix

Some useful DM tricks

DM ROI tool:

1 il 5 _:_ = Hint: to select a square area, hold down SHIFT.
o~ - To select powers of two, hold down SHIFT-ALT.
DM Zoom tool:

| [} QL / % [] © || Hint: to demagnify, press ALT.

HREM Mouse tool

. " Hint: to delete any spot, just

» o B N

" Cap '65 Lo Q @ =] click on the mouse mark with
the SHIFT key down.

DM Image Display Command

e =

Wl Projecl exx o || = ) i Projecti o[> /B )

)

Hint: to change the color map of
any image, press the right mouse
button on it, select ImageDisplay,
and modify the options as desired.

For example, it is useful to set

ImageDisplay...

manually the color range of each
Display Type » map to be the same, so as to be able
to compare each other.

33



PPA for DM Manual

Quick Reference Guide

The PPA Main Menu PeakPairs |
Fourier Space Noise Filter 1 4
Real Space Noise Filter 4

Set Reference Base Vectors

Motif Detection 4
Find Peaks 1 4

Find Peak Pairs
Displacement Maps
Define Reference

Strain Map...

Repeat Project...
Project 1 4
Image Group 1 4

Analyze Lattice Points

Analyze Column Positions...
Histogram from Spreadsheet
Show/Hide >
Add Color Marker

Create Vector Map...

Distortion Correction 4

Help 1 4

The commands in the PPA menu are described below.

Command

Description

Fourier Space Noise

Filter (see sub menus)

Reduces noise using Fourier space filter.

Real Space Noise Filter

(see sub menus)

Reduces noise using Real Space Filter.

Set Reference Base
Vectors

Set the reference base vectors manually on a
real-space noise-filtered image or an image after
Motif detection.

Note: Bragg filter sets the reference base vectors
automatically.

Motif Detection
(see sub menus)

Detects repeating units (unit cells) using a Motif (small
reference region).
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Find Peaks
(see sub menus)

Locates peaks of intensity in an image.
Note: Reference base vectors should be defined
beforehand.

Find Peak Pairs

Calculates pairs of peaks along two reference base
vectors automatically.

Displacement Maps

Generates horizontal and vertical displacements
along the two directions defined by the basis vectors

Define Reference

Changes the displacement values, so as to obtain a
uniform displacement in the chosen area.

Note: the area should be selected previously using
the ROI tool on any displacement image

Strain Map... Calculates strain maps (exx,eyy,exy and eyy) at any

(see Dialog) desired angle.

Repeat Project... Generates strain maps and other outputs for the front

(see Dialog) most image using the same conditions of a selected
project.

Project Menu to manage all the images in a particular project.

(see sub menus)

Image Group Menu to close or save groups of images within a

(see sub menus)

particular project.

Analyze Lattice Points

Generates a spreadsheet of data (peak position, peak
intensities, strain values) for each peak

Analyze Column

Positions... (see Dialog)

Analyzes column positions with respect to its relative
position within the grid

Histogram from
Spreadsheet

Calculates a different histogram for each column in
the spreadsheet

Show/Hide
(see sub menus)

Shows/hides a selected annotation on the image.

Add Color Marker

Adds a color bar and the low and high display ranges.
You can move the whole color marker or change its
size. Since the display ranges are text annotations,
you can move and edit them as you like. The color
marker can be placed outside of the image display.
You can rotate and flip using Edit commands. (The
ratio of the color bar is fixed.)

Create Vector Map...

(see Dialog)

Create a vector map from two component images
selected in the dialog.

Distortion Correction
(see sub menus)

Eliminates systematic distortions present in the image
based on the measurement of an ideal distortion-free
image.
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i Power Spectrum |

Fourier Space Noise Filter SubMenu |

Bragg Filter...

Component

Description

Power Spectrum

Calculates the Fourier transform of the front most
image, and displays the power at each frequency
(commonly called the Power Spectrum).

Bragg Filter...
(see Dialog)

Calculates Bragg Filter using the spots selected in the
Power Spectrum. The shape and size of the mask
can be defined by the user in the dialog.

Note: Spots should be selected beforehand in the
Power Spectrum using the Mouse Tool.

Note: The first and second spots defined the
Reference Base Vectors in real space.

Bragg Filter Dialog

The components of the dialog are described below.

Dialog i Bragg Filter [
Project Name: |Project1
Size:
Smoothing Width: | 5.0
(V] Oval Ratio: | 1.0
Direction: |0.0 degree
[ OK ] [ Cancel ]
Component Description

Project Name

Name given to the group of images and results

Size

Defines mask radius of hard cut-off (beyond which
values are set to zero).

Smoothing Width

Specifies mask smoothing width in pixels

Oval Ratio Defines the shape of the oval, as major to minor axis
ratio
Direction Sets the prescribed masks angle, in degrees
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Adaptive Wiener Filter...

Low Pass Filter...

Component Description

Adaptive Wiener Filter... | Remove noise from the image using an adaptive
(see Dialog) Wiener filter based on a local variance.

Low Pass Filter... Calculates and applies a Low Pass filter to the image
(see Dialog)

Adaptive Wiener Filter Dialog

Dialog i- Wiener Filter [
New Project: IProjT
Adaptive Average: [1_ x2+1 pixels
Noise Estimation: IT x2+1 pixels
[ OK ] [ Cancel ]
Component Description
New Project Name given to the group of images and results
Adaptive Average Window size [(2N+1)x(2N+1) pixels] to be used in the

calculation of the adaptive average

Noise Estimation

Window size [(2N+1)x(2N+1) pixels] to be used in the
calculation of the noise estimation

Low Pass Filter Dialog

Dialog iz Low Pass Filter =
New Project: [Projecti|
Radius(pixe |} r
oK I Cancel I
Component Description
New Project Name given to the group of images and results
Radius(pixel) The radius of the mask in pixels
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x-Corr Histogram...

x-Corr with Refined Motif
Find Motif Centers...

Component Description
x-Corr Histogram... Calculates Cross-Correlation Histogram between the
(see Dialog) selected reference region (motif) and the original

image.

Note: The left edge of the selection in the histogram is
used as a threshold to obtain the refined motif in the
next step.

x-Corr with Refined
Motif

Obtains a refined motif, and then calculates
Cross-Correlation Histogram between the refined
motif and the original image.

Note: The left edge of the selection in the histogram is
used as a threshold to find good motifs in the next
step.

Find Motif Centers...
(see Dialog)

Finds the centers of good Motifs in the image.

x-Corr Histogram Dialog

Dialog iz x-Corr Histogram &J
Approximate Column Size (diameter): | 10.0|
Minimum Motif Distance: | 15.0
[ OK ] [ Cancel ]
Component Description

Approximate Column
Size (diameter)

Specifies an approximate atom column size (the
minimum distance between atom column peaks).
(This parameter is used in x-corr with Refined Motif
to define peaks in the refined motif.)

Minimum Motif Distance

Specifies a minimum distance between allowed
motifs. (This parameter is used in Find Motif
Centers...)
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Find Motif Center Dialog

Dialog

7

i Find Motif Cen...@
Peak Threshold: |0.835

(V| Show all points
(] show stacked motif

[ OK ][ Cancel ]

Component

Description

Peak Threshold

Specifies a minimum for the intensity of allowed
Peaks.

Show all points

Shows also the Motif centers in blue that were
rejected by the cross-correlation threshold and/or the
minimum motif distance criteria. (Namely, all the peak
points are displayed in red or blue color.)

Show stacked motif

Make a stacked image from detected motifs.

Find Peaks SubMenu

Peak Histogram...

Find Peak Positions...

Remove Peaks

Add Peaks
Component Description
Peak Histogram... Calculates a histogram of peaks intensities, helping
(see Dialog) the user to determine a precise value for Peak

Threshold.

Find Peak Positions...

(see Dialog)

Locates peaks of intensity in a filtered image. A
threshold for the minimum allowed peak intensity and
a minimum distance for peaks can be defined.

Note: The left edge of the selection in the histogram is
used as a threshold to find good peaks.

This threshold can be changed in the dialog below.

Remove Peaks

Remove the peaks, which are selected by using
HREM Mouse.

Add Peaks

Refine and add the peaks, which are selected by
using HREM Mouse.
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Peak Histogram Dialog

Dialog i~ Peak Histogram [
[ ]Invert Peaks
[ OK ] [ Cancel ]
Component Description
Invert Peaks It allows the user to calculate intensity minima

histograms (instead of maxima)

Find Peak Positions Dialog

Dialog iz Find Peaks [
[ Invert Peaks
Peak Threshold: |0.825
Minimum Peak Distance: | 3.0
(V] Show Local Maxima
[ OK ] [ Cancel ]
Component Description
Invert Peaks It allows the user to calculate intensity minima
(instead of maxima)
Peak Threshold Specifies a minimum for the intensity of allowed

peaks

Minimum Peak Distance

Specifies a minimum distance between allowed peaks

Show Local Maxima

Show local maxima (of 8-neighbourhood) as blue
points.
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iz Strain Map X

Option

Angle of x-axis to horizontal: | 0.0

Show the following images
[V] Strain Matrix
Independent
@) Symmetric
(¥ Mean Dilatation
(V| Rotation Angle

[ overlay

[ OK ][ Cancel ]

Option

Description

Angle of x-axis to
horizontal

Specifies the angle of the direction to be considered
as x-axis.

You can specify the orientation of the x-axis by
placing a Line ROI on the HREM image. In this case,
the angle of the Line ROl appears here automatically.
Note: If angle is set equal to 0, horizontal and vertical
directions are assumed to be x and y coordinate axis
respectively.

Strain Matrix

Specifies the images to be shown

Independent

Images of du/dx, du/dy, dv/dx, dv/dy to be displayed

Symmetric

Images of &4, €y, and ey, to be displayed.

Mean Dilatation

Image of 9y, to be displayed (average of ex and eyy).

Rotation Angle

Image of wy, to be displayed. Values in degrees and
anticlockwise positive.

Overlay

Shows the strain at each atomic column, and
displayed as coloured dots over the original image
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Repeat Project Dialog

Dialog

iz Repeat Project léj

New Project: |Project3

Project image to be repeated:

Project! Brage Filtered Testimage ;]

Select
(" Find Peaks
(" Find Peak Pairs
(" Displacement Maps
(¢ Strain Map

oK | Cancel |

Component

Description

New Project

Defines the name of the new project.

Project image to be
repeated

Selects an open project to be used to generate strain
maps and other outputs for the front most HREM
image.

Note: If you want to use the project created during the
previous session, you may want to open it again.

Find Peaks

Repeats Find Peaks Operation.

Find Peak Pairs

Repeats Find Peak Pairs Operation.

Displacement Maps

Repeats Displacement Maps Operation.

Strain Map

Repeats Strain Map Operation.

Project Sub-Menu e
Show
Save
Close
Component Description
Hide Hides all the images in a project.
Show Shows all the images in a hidden project.
Save Saves all the images in a project (with save dialog
window).
Close Closes all the images in a project without saving.
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Save

Close
Component Description
Save Saves (with dialog) all images in a project of the same
type as the front most image (e.g. strain map images).
Close Closes (without saving) all images of the same type

as the front most image.

Analyze Column Positions Dialog

The user will have the option to decide the distances and/or angles to be

evaluated.

Distance Tab

iz Analyze Column Positions [éj

Distance l Angle I Option I

M1 @2 [03

Distances from the checked point(s) to
other points will be evaluated.

[ OK ] [ Cancel

)

The number of each check box corresponds to the assigned number to the
mouse click. All the distance(s) from the checked point to other points will be

calculated.

Angle Tab

i= Analyze Column Positions &J

Distance Angle I Option I
[1 #2 [E]3
Checked point(s) will be a vertex of angle(s)
subtended by two other points.
[ OK ] [ Cancel ]

The number of each check box corresponds to the assigned number to the
mouse click. All possible angle(s) whose vertex corresponds to the checked

point will be calculated.
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Option Tab i= Analyze Column Positions =

Distance I Angle Option
|| Position (Pos) number on the image
Column coordinate: (7) Image origin (topeft)

@ Motif origin (top-eft)

[ OK ] [ Cancel ]
Component Description
Position (Pos) number | Display position number (Left column of the spread
on the image sheet) on original image.
Column coordinate (Motif Detection only)
You can select the origin of column positions in the
Motif.
Show/Hide Sub-Menu Peaks
Peak Pairs
Motif
Command Description
Peaks Displays the circle at the peak positions on the image.
Peak Pairs Displays the peal-pair lines on the image.
Motif Shows/hides Motif
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Create Vector Map Dialog

Dialog pi- Create Vector Map [
Select two components
Horizontal: [O: Project2 D1h v]
Vertical: [S: Project2 D1iv v ]
Arrow
Interval: |16| pixels
Length Scale: | 1.0
(Length = Scale * Interval)
Color: R [100 % G[20 % B[s0 %
[ OK ] [ Cancel ]
Component Description
Horizontal Select an image corresponding to the horizontal
component.
Vertical Select an image corresponding to the vertical
component.
Interval Specifies an interval to draw arrows (in pixel)

Length Scale

Specifies an arrow length. An actual length is Interval
* Scale (in pixel)

Color

Specifies an arrow color in RGB.
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Correct Distortion...

Obtain Distortion Info

Rectify Image...

Command

Description

Correct Distortion...

Rectifies any distorted image using the distortion
information obtained previously from an undistorted
sample using the “Obtain Distortion Info” command
below.

A dialog to select two images will be opened.

Obtain Distortion Info

Extracts distortion information from the Bragg image
of an undistorted crystal after calculating Peak Pairs.
This information will be used by the “Correct
Distortion” command above.

Rectify Image...
(see Dialog)

Rectifies an image of an undistorted crystal after
calculating Peak Pairs.

Default basis vector are automatically chosen from
the first and second selected Bragg spots. Basis
vectors can also be manually specified/modified by
the user.

Rectify Image Dialog

Dialog

'

|5

i~ Rectify Image

Base Vector 1

Length: |8.6 (8.6019)
Angle: |-135.2 (-135.206)

Base Vector 2

Length: |8.59 (8.58744)
Angle: [ 134.8 (134.792)

[ o

][ Cancel ]

Component

Description

Length

Length of base vector considered for image
rectification, measured in pixels

Angle

Angle of base vector considered for image
rectification, measured in degrees
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